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Preface

TIBCO BusinessConnect™ EDI Protocol powered by Instream® is the TIBCO 
business-to-business (B2B) solution for transferring EDI documents between trading 
partners. This manual describes how to use the Gateway protocol.

Topics

• Related Documentation, page x

• Typographical Conventions, page xii

• TIBCO Product Documentation and Support Services, page xiv
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x | Related Documentation
Related Documentation

This section lists documentation resources you may find useful.

TIBCO BusinessConnect EDI Protocol powered by Instream Documentation

The following documents form the TIBCO BusinessConnect EDI Protocol powered by 
Instream documentation set:

• TIBCO BusinessConnect EDI Protocol powered by Instream Installation Read this 
manual to learn about installing and deploying TIBCO BusinessConnect EDI Protocol 
powered by Instream. 

• TIBCO BusinessConnect EDI Protocol powered by Instream User’s Guide Read this 
manual for instructions on using the product to configure all the EDI protocols.

• TIBCO BusinessConnect EDI Protocol powered by Instream EDIFACT 
Configuration Read this manual for instructions on configuring the EDIFACT 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Gateway 
Configuration Read this manual for instructions on configuring the Gateway 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Service 
Configuration Read this manual for instructions on configuring the Service protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream TEXT 
Configuration Read this manual for instructions on configuring the TEXT protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream TRADACOMS 
Configuration Read this manual for instructions on configuring the TRADACOMS 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration Read 
this manual for instructions on configuring the X12 protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Release Notes Read the 
release notes for a list of new and changed features. This document also contains lists 
of known issues and closed issues for this release.
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Other TIBCO Product Documentation

You may find it useful to read the documentation for the following TIBCO products:

• TIBCO ActiveMatrix BusinessWorks™

• TIBCO ActiveMatrix BusinessWorks™ Plug-in for BusinessConnect™

• TIBCO Administrator™

• TIBCO BusinessConnect™

• TIBCO BusinessConnect™ Palette

• TIBCO Business Studio™

• TIBCO Designer™
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

ENV_HOME

TIBCO_HOME

TIBCO products are installed into an installation environment. A product installed into 
an installation environment does not access components in other installation 
environments. Incompatible products and multiple instances of the same product must be 
installed into different installation environments.

An installation environment consists of the following properties:

• Name Identifies the installation environment. This name is referenced in 
documentation as ENV_NAME. On Microsoft Windows, the name is appended to the 
name of Windows services created by the installer and is a component of the path to 
the product shortcut in the Windows Start > All Programs menu. 

• Path The folder into which the product is installed. This folder is referenced in 
documentation as TIBCO_HOME. 

TIBEDI_HOME TIBCO BusinessConnect EDI Protocol powered by Instream installs into a directory 
within a TIBCO_HOME. This directory is referenced in documentation as 
TIBEDI_HOME. The default value of TIBEDI_HOME depends on the operating system. 
For example, on Windows systems, the default value is C:\tibco\bc\version\protocols\tibedi.

code font Code font identifies commands, code examples, filenames, pathnames, and output 
displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code font Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of particular 
interest.

• In command syntax, to indicate the default parameter for a command. For example, 
if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]
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italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO BusinessConnect EDI 
Protocol powered by Instream Installation.

• To introduce new terms. For example: A portal page may contain several portlets. 
Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. For 
example: MyCommand PathName.

Key 
combinations

Key names separated by a plus sign indicate keys pressed simultaneously. For example: 
Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other. 
For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example, 
an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply the 
information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss 
or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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TIBCO Product Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO 
Support, or join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation 
website mainly in the HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current 
than any other documentation included with the product. To access the latest 
documentation, visit https://docs.tibco.com. 

Documentation for TIBCO BusinessConnect EDI Protocol powered by Instream is 
available on the 
https://docs.tibco.com/products/tibco-businessconnect-edi-protocol-powered-by-instream
Product Documentation page.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

• For an overview of TIBCO Support, and information about getting started with 
TIBCO Support, visit http://www.tibco.com/services/support

• For accessing the Support Knowledge Base and getting personalized content about 
products you are interested in, visit the TIBCO Support portal at 
https://support.tibco.com.

• For creating a Support case, you must have a valid maintenance or support contract 
with TIBCO. You also need a user name and password to log in to 
https://support.tibco.com. If you do not have a user name, you can request one by 
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Chapter 1 Overview

This chapter describes the Gateway protocol for TIBCO BusinessConnect EDI Protocol 
powered by Instream. 

Topics

• Product Overview, page 2

• Outbound Batching, page 4

• Transport Gateway, page 7

• Message Routing, page 8
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Product Overview

TIBCO BusinessConnect EDI Protocol powered by Instream is the TIBCO B2B solution 
for transferring EDI documents between trading partners. 

The protocol can be used for all EDI integration scenarios, including connecting directly 
to trading partners using Internet or through value added networks (VANs), and provides 
common format standards support for various EDI document standards including the X12, 
TEXT, TRADACOMS, and EDIFACT standards. For more information on setting up 
TIBCO BusinessConnect EDI Protocol powered by Instream to exchange X12, TEXT, 
TRADACOMS, and EDIFACT documents with your trading partners, refer to the 
configuration guides for these protocols.

Unlike the X12, TEXT, TRADACOMS, and EDIFACT standards, Gateway does not 
represent a well-known common format standard in the EDI document exchange industry; 
instead, Gateway facilitates the transport of EDI documents to and from your trading 
partners either directly or through a VAN. Gateway also helps you orchestrate the 
processing of incoming EDI documents received by TIBCO BusinessConnect and is an 
important component of TIBCO BusinessConnect EDI Protocol powered by Instream.

Figure 1   Gateway Diagram

As shown in Figure 1, Gateway provides three major functionalities:

• Outbound Batching Monitors and manages activities for batching of outbound X12 
and EDIFACT transactions. See Outbound Batching on page 4.

• Transport Gateway Serves as a common transport gateway for exchanging EDI 
documents with your trading partners that bypasses the EDI validation and XML 
conversion. See Transport Gateway on page 7.

• Message Routing Identifies and distributes inbound EDI documents for EDI message 
validation and XML conversion processing. See Message Routing on page 8.

TIBCO BusinessConnect EDI 
Protocol powered by Instream: 

Gateway

TIBCO BusinessConnect EDI Protocol 
powered by Instream: X12, EDIFACT,  

TRADACOMS, and TEXT

TIBCO BusinessConnect

Outbound Batching 
Transport Gateway
Message Routing
Transport Acknowledgement

Message Validation
XML Conversion
EDI Acknowledgement

Trading Partner Management
Transport Configuration
Security
Logging
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Outbound Batching

With TIBCO BusinessConnect EDI Protocol powered by Instream X12 and EDIFACT 
protocols, outbound transactions can be sent individually with one outgoing EDI 
document containing only one transaction enclosed in a single interchange envelope. 
Outbound transactions can also be batched together into an EDI document that contains 
multiple interchange envelopes, and each envelope contains multiple transactions of the 
same type. However, the above batching functionality cannot batch transactions targeting 
different trading partners into a single EDI document. The outbound batching has this 
functionality in Gateway protocol. Transactions of different types and targeting different 
trading partners can be batched together into a single outgoing EDI document. Such EDI 
documents contain multiple interchange envelopes, and each envelope contains one type 
of transaction targeting one trading partner. 

By providing this batching functionality, the Gateway protocol represents the commercial 
VANs where batches of transactions are distributed to the target trading partners.

Multiple trading partners can share the same Gateway for batching X12 and EDIFACT 
transactions by specifying the same Gateway name in their batching configuration. The 
batch EDI document contains multiple interchange envelopes, and each interchange 
envelope contains a batch of transactions for one trading partner.

A diagram of outbound batching is shown in Figure 2.

Batching is not available for TEXT and TRADACOMS.
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Figure 2   Outbound Batching

Each X12 or EDIFACT transaction goes through message validation and conversion from 
the XML request to the standard EDI format. The messages that are configured to be 
delivered in batch are persisted into the database after successful message validation and 
conversion. 

You configure a maximum count of messages or a scheduled time interval. When a batch 
of persisted transactions reaches this count or interval, all the persisted transactions are 
retrieved back from the database and collated into a single interchange envelope. Each 
transaction in the resulting EDI document is assigned a unique control number within the 
interchange envelope before the batch is transmitted to your trading partner. The batch is 
transmitted using the transport that you have chosen as a default.

The Gateway protocol provides two mechanisms of controlling the batching of X12 or 
EDIFACT transactions at the trading partner level:

Outbound XML 
Message Request

Validated EDI Single 
Transaction Message Pending Batch 

Transactions

Instream 
Translation

EDI Outbound 
Batching Module

BusinessConnect 
Repository

Guideline,  XSD and map files

Scheduler

Collation and 
Packaging

EDI Multiple Interchange Envelope Messages with 
Batches of Transactions

Outbound batching is enabled by the Batching and Scheduled Transmission options for an 
X12- or EDIFACT-enabled trading partner. 

For more information on these options, refer to the chapters on setting up of the trading 
partners in the configuration guides for X12 or EDIFACT protocols.
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• Maximum number of transactions in each batch. When the cumulated number of 
transactions reaches the maximum count, the batch is marked for transmission 
immediately. A new batch will be created for subsequent new outgoing transactions.

• Regular time interval between the start time and the end time of the scheduling 
window. 

Batching times are defined based on the start time in increments of the specified 
interval until the end time of the scheduling window, all outgoing transactions are 
cumulated before the next batching time.

For example: if the start and end time is from 9:00 AM. to 6:00 PM. with a scheduled 
time interval of 30 minutes, the batches are scheduled at 9:00 AM., 9:30 AM., 10:00 
AM., and so on.

There are also additional options that extend the batching behavior at the transaction level. 
These options are:

• Always If the batch scheduler is enabled in the trading partner Scheduled 
Transmission tab, all transactions of this transaction type for that trading partner will 
be placed into batches. The batches will be sent based upon the settings in the business 
agreement Scheduled Transmission tab. See Scheduled Transmission Tab on 
page 53.

• Never You can configure a transaction type to be excluded from the batching facility 
so the transaction will always be transmitted directly to your trading partner 
immediately. For example: All invoices for a particular trading partner are always sent 
directly as received from the back-end system.

• Exclusively TIBCO BusinessConnect can organize transactions so that each 
interchange envelope contains only one type of transaction. For example: All purchase 
orders for a particular trading partner are always packaged into a single interchange 
envelope. The exclusive batching feature includes two options in which TIBCO 
BusinessConnect can transmit:

— Each interchange in its own document

— Multiple interchanges in a single document

To learn more about these options, see TIBCO BusinessConnect EDI Protocol Powered by 
Instream, X12 Configuration, Outbound Action Tab. 
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Transport Gateway

The Gateway protocol provides a facility for sending well-formed EDI documents 
generated from the back-end systems directly to your trading partner without EDI 
message validation and XML or TEXT conversion. This function is particularly useful 
when your back-end system or legacy application is capable of generating well-formed 
EDI documents. In this scenario, Gateway serves as the transport gateway to provide 
transport connectivity, such as AS1 and AS2, with your trading partner.

No EDI guideline validation is done for documents that are picked up from the Gateway 
polling directory. The Gateway outbound EDI file request poller provides transport 
connectivity to your trading partners without EDI message validation and XML 
conversion. Therefore, it functions as a pass-through gateway for sending EDI documents.

EDI documents that are picked up under the polling directory for Gateway will not be 
examined for multiple interchanges to identify the trading partner. The Gateway protocol 
generates only one outbound request message to the corresponding Gateway trading 
partner. The trading partner must be specified in the name of the parent directory from 
which the document is being picked up.

If the Gateway polling directory is specified as

/tibco/bc/outbound/request/*.* 

the outbound file poller recursively searches through all subdirectories of 
/tibco/bc/outbound/request/ for files that match the pattern *.*. 

For example, to transmit the X12_5010_850.dat file to the trading partner VAN1, put it in the 
subdirectory /tibco/bc/outbound/request/VAN1. TIBCO BusinessConnect will pick up the file and 
generate a single outbound request to the Gateway trading partner VAN1.

Gateway does not perform any EDI guideline validation or EDI to XML (or EDI to 
TEXT) conversion of any outbound documents, whether they come from the outbound file 
poller directory or private process communication; it functions as a pass-through gateway 
for sending EDI documents.
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Message Routing

When an EDI document is received from a trading partner by the Gateway protocol 
through the various supported inbound transports Gateway handles all the activities in 
acknowledging your trading partner at the transport level. 

Transport level acknowledgment includes message decryption and authentication as well 
as composing the receipt synchronously or asynchronously. Gateway then inspects the 
message and identifies the document type in preparation for protocol standard-specific 
processing. Protocol standard-specific processing includes splitting the incoming EDI 
document into multiple interchange envelopes if necessary and redirecting each 
interchange envelope for EDI message validation and XML conversion. 

After this splitting, the EDI message validation and XML conversion is handled by 
protocol standard-specific processing such as the X12, TEXT, TRADACOMS, or 
EDIFACT standards. Corresponding protocol standard level acknowledgments, such as 
X12 997 or EDIFACT CONTRL, are generated accordingly.

The Gateway protocol also provides an option for bypassing the protocol standard specific 
message validation and XML conversion based on the detected document type. This 
option is available through the Operations Editor for the corresponding document type. By 
disabling the protocol standards specific processing, Gateway can simply serves as the 
inbound transport gateway for receiving and routing inbound EDI documents to your 
back-end systems or legacy applications which are already capable of processing a 
well-formed EDI documents.
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Chapter 2 Tutorial — Getting Started

This chapter gives an overview of how to use TIBCO ActiveMatrix BusinessWorks with 
TIBCO BusinessConnect EDI Protocol powered by Instream. 

In this tutorial you will configure trading partner information, configure a private process 
to communicate with TIBCO BusinessConnect EDI Protocol powered by Instream, and 
run the tutorial.

Topics

• Overview, page 10

• Prerequisites, page 11

• Configuring the Initiator, page 12

• Configuring Private Processes, page 16

• Running the Tutorial, page 20
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Overview

In this tutorial you use TIBCO ActiveMatrix BusinessWorks and TIBCO 
BusinessConnect EDI Protocol powered by Instream running on one machine to send a 
850 transaction using the Gateway protocol to a trading partner. 

Normally the trading partner is represented by another B2B engine running on another 
machine. However, this tutorial is run on a single machine and when the 850 is sent to the 
trading partner, the transport properties are defined to store the request in a directory on 
the local file system.

The identifier information is as follows:

When you run the tutorial, the following steps occur:

1. TIBCO Designer/TIBCO Business Studio reads a file which contains the data for 850.

2. TIBCO Designer/TIBCO Business Studio sends the EDI data to TIBCO 
BusinessConnect EDI Protocol powered by Instream.

3. TIBCO BusinessConnect EDI Protocol powered by Instream sends the interchange to 
the trading partner without validating it.

4. FILE transport is used to simulate sending an interchange to a trading partner. By 
using FILE transport, the interchange is written to a file on the local file system when 
it is sent to the trading partner.

The following sections describe how to set up and run the tutorial. The steps involved in 
setting up TIBCO BusinessConnect EDI Protocol powered by Instream to run the tutorial 
are the same steps that have been discussed in TIBCO BusinessConnect EDI Protocol 
powered by Instream, User’s Guide, Chapter 3, "Exchanging Documents": 

• Trading Partner Setup

• TIBCO ActiveMatrix BusinessWorks Process Assembly
TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Prerequisites

Before starting the tutorial, perform the following steps:

1. Install the following software packages:

a. TIBCO BusinessConnect (Server)

b. TIBCO BusinessConnect Palette or TIBCO ActiveMatrix BusinessWorks Plug-in 
for BusinessConnect

c. TIBCO Foresight® Instream® Standard Edition

d. TIBCO Foresight® Translator Standard Edition

e. TIBCO BusinessConnect EDI Protocol powered by Instream

2. If you are not familiar with Gateway, read Chapter 1, Overview, on page 1.

3. Review TIBCO BusinessConnect EDI Protocol powered by Instream User’s Guide, 
Chapter 3, "Exchanging Documents."

4. See TIBCO BusinessConnect Interior Server Administration and the TIBCO 
BusinessConnect Trading Partner Administration for complete information on setting 
up and running TIBCO BusinessConnect.

5. Review "Setting Up Trading Partners" in TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide.

6. Activate TIBCO BusinessConnect EDI Protocol powered by Instream.
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration
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Configuring the Initiator

This section steps you through the activities you need to perform to configure the host and 
trading partner on the Initiator machine. As explained before, the trading partner is 
normally represented by another B2B engine running on another machine. However, this 
tutorial is run on a single (Initiator) machine.

To proceed with the tutorial, perform the following steps:

• Set Up a Host, page 12

• Set Up a Trading Partner, page 13

• Configure the Business Agreement, page 15

• Deploy the Initiator Server, page 15

Set Up a Host

On the Initiator machine, you will set up a trading host. If this is the first time you are 
configuring a host on this machine after installing EDI protocols, follow these steps: 

1. Start Creating a New Trading Host, page 12

2. Activate the Trading Host, page 13

Start Creating a New Trading Host

To create your trading host and set it as the default host, perform the following steps:

1. Click the BusinessConnect > Participants link in the left panel. 

2. Click the New button in the right panel.

3. Type Company1 in the Name field.

4. Select Host in the Type list.

5. Click OK.

6. Click Apply.

Enable the Gateway Protocol for the New Host

All EDI protocols are enabled by default after installation. In order to configure and 
activate any of the protocols, you must disable all other unconfigured protocols. Once the 
protocols are configured, they can be enabled or disabled at any time: this procedure is 
needed only when configuring protocols for the first time.
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If no protocols have been enabled:

1. Click the Protocols tab.

2. Select the check boxes next to all other EDI protocols except for Gateway. 

3. Click Disable.

If enabling an additional protocol:

1. Click Enable.

2. In the list of non-enabled protocols, select the check box next to Gateway.

3. Click OK and Save.

Activate the Trading Host

1. Click the Company1 link.

2. Select the Active check box.

3. Click Save. 

4. Select BusinessConnect > System Settings > General and verify that Company1 is 
selected as the default host. 

Set Up a Trading Partner

The trading partner setup consists of these steps:

• Create a Trading Partner, page 14

• Enable the Gateway Protocol, page 14

• Set the Transport, page 14

Create a Trading Partner 

To set up the trading partner, perform the following steps:

1. Click the BusinessConnect > Participants link in the left panel. 

2. Click the New button in the right panel.

3. Type Company2 in the Name field.

4. Select Partner in the Type list.

Saving of the trading host will succeed only if the protocol is properly configured: 
protocol is binded and a qualifier and ID are provided.
 TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration



14 | Chapter 2  Tutorial — Getting Started
5. Click OK.

6. Select the Active check box.

7. Click Save.

Enable the Gateway Protocol

1. Select Conmpany2 link.

2. Click the Protocols tab.

3. Click the Enable button.

4. Select the Gateway check box.

5. Click OK.

Set the Transport

To set the transport:

1. Click the Gateway link.

2. Click the Transports tab.

3. Click Add.

4. Provide the transport name as FILE and select FILE from the Type list.

5. Click OK.

6. In the URL field, type C:/testEDI/out.

7. Click Save three times.

Forward slashes are used in the path as opposed to the Windows backslash. This is 
because the fields of the TIBCO BusinessConnect console are HTML user interface 
text components. As with any HTML user interface text component, the backslash (\) 
is treated as an escape character.
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Configure the Business Agreement

1. Click the BusinessConnect > Business Agreements link in the left panel. 

2. Click the New button in the right panel.

3. Select the Company1 radio button in the Host Party area and the Company2 radio 
button in the Partner Party area.

4. Click OK.

5. Click the Add Protocol Binding button.

6. Select the Gateway check box.

7. Click OK.

8. Click the Gateway link.

9. Click the Transports tab.

10. Make sure that FILE is selected in the Primary Transport list in the Outbound 
Transports for Host ‘Company1’ area.

11. Click Save twice.

Deploy the Initiator Server

The Initiator server must be set up to communicate with its trading partners. To do so, 
follow these steps

• Create the deployment configuration. See TIBCO BusinessConnect Interior Server 
Administration for information on deployment configurations.

• Deploy BusinessConnect and start the server.
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Configuring Private Processes

TIBCO BusinessConnect EDI Protocol powered by Instream contains an example TIBCO 
ActiveMatrix BusinessWorks project which sends a 850 to TIBCO BusinessConnect. 

This section describes how to configure private processes in the following ways: 

• Configuring Private Processes in TIBCO Designer, page 16

• Configuring Private Processes in TIBCO Business Studio, page 18

Configuring Private Processes in TIBCO Designer

To configure private processes in TIBCO Designer:

1. Opening the TIBCO ActiveMatrix BusinessWorks Project, page 16

2. Configuring Connections to BusinessConnect, page 17

Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the example TIBCO ActiveMatrix BusinessWorks project in TIBCO Designer, 
perform the following steps:

1. Start TIBCO Designer.

2. Click New empty project.

3. In the Save Project dialog, click Cancel.

4. Select Project > Import Full Project.

5. Click the ZIP Archive tab. 

6. Navigate to BC_HOME\protocols\tibedi\samples\bw\Gateway_Text

7. Select Gateway_Text.zip and click Open. 

8. Click OK. 

The Import - Options dialog is displayed.

9. In the Options tab, click Try rename in case of name conflict. 

10. Click Apply.

11. Select Project > Save As.

12. In the Project Directory file chooser, navigate to 
BC_HOME\protocols\tibedi\samples\bw\Gateway_Text.

13. Click OK twice.
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14. When a dialog is displayed asking to use the directory as a project directory, click Yes. 
The zip archive file is deleted.

The window shown in Figure 3 is displayed.

Figure 3   TIBCO ActiveMatrix BusinessWorks Project

15. Click the Global Variables tab.

16. Verify that the global variable BCHome is set to your TIBCO BusinessConnect 
installation directory.

If you made any changes, save the project but do not exit TIBCO Designer.

Configuring Connections to BusinessConnect

To configure connections to BusinessConnect, perform the following steps:

1. Click the Project tab.

2. In the EDI Server Connections folder, double-click BCServerConfigGateway.
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3. Click the BusinessConnect Server Access tab.

a. Select the JDBC driver you use to communicate with the BusinessConnect 
configuration store from the JDBC Driver Type list.

b. Type the URL for the configuration store in the JDBC URL field.

c. Type the configuration store user name and password in the DB User and DB 
Password fields.

d. Click the Apply button.

4. Click the Configuration tab.

5. Click the Update from Configuration Store button.

6. Select Gateway from the Protocol Name list.

7. Click the Import Selected Business Protocol button. When you import the protocol, 
TIBCO ActiveMatrix BusinessWorks retrieves schema information from the TIBCO 
BusinessConnect configuration store and puts it in the BCSchemas project folder. 

Figure 4   BusinessConnect Server Access

8. Click Apply.

9. Click the Save icon to save the project.

Configuring Private Processes in TIBCO Business Studio

To configure a private process in TIBCO Business Studio:

1. Opening the TIBCO ActiveMatrix BusinessWorks Project, page 19

2. Configuring Connections to TIBCO BusinessConnect, page 19
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Opening the TIBCO ActiveMatrix BusinessWorks Project

To open the TIBCO ActiveMatrix BusinessWorks project in TIBCO Business Studio:

1. Start TIBCO Business Studio.

2. Click File > Import. 

3. On the Import page, expand the General folder and select Existing Studio Projects 
into Workspace. Click Next. 

4. Click Browse next to the Select archive file field to navigate to the 
BC_HOME/protocols/tibedi/samples/bw/Gateway_Text directory, and select the 
Gateway_Text_for_bw6.zip file. Click Open.

5. Click Finish.

After importing the sample, you also need to perform the following steps:

1. Expand Gateway_Text > Module Descriptors in the Project Explorer view.

2. Double-click Module Properties.

3. Change the default values of the BCHome, TPName, and DataFile properties according to 
your environment.

Configuring Connections to TIBCO BusinessConnect

To configure connections to TIBCO BusinessConnect:

1. In the Project Explorer view, expand Resources and double-click 
BCServerConfigGateway.bcResource.

2. Click the Server Access tab.

3. Enter information as explained in step 3.

4. Click the Configuration tab, and click Update from Configuration Store.

5. Select Gateway from the Protocol Name list.

If you select the Select Operations check box, you can select any of the 
configured/imported operations. For this tutorial, select all operations and click OK.

6. Click Import Selected Business Protocol. 

When you import the protocol, TIBCO ActiveMatrix BusinessWorks retrieves 
information from the TIBCO BusinessConnect configuration store and puts them in 
the project folder.

7. Click Save.
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Running the Tutorial

To run the tutorial, follow these steps:

1. Set the Input Data, page 20

2. Send the 850 Transaction, page 21.

3. Check the results of sending the message. 

See Expected Results on page 22 and View the Audit Log on page 23.

Set the Input Data 

1. Expand the Gateway_Text > EDI Outbound folder.

2. Select the process inside the folder and press the F12 key.

Figure 5   Input Data for EDI Outbound/Send EDI as Text

3. Type the following input data:

— BCHOME: BC_HOME , such as C:\tibco\bc\version

— DataFile: X12_5010_850.dat 

— TPName: Company2

4. Click OK.

The steps of how to load and run private processes in TIBCO Business Studio are similar 
to TIBCO Designer. See TIBCO ActiveMatrix BusinessWorks Documentation for more 
details.
TIBCO BusinessConnect EDI Protocol powered by Instream Gateway Configuration



Running the Tutorial | 21
Send the 850 Transaction

The Send EDI As Text Through Gateway process in presented in Figure 6.

Figure 6   Send EDI As Text Through Gateway

This process:

1. Reads a file containing EDI data for X12 850.

2. Constructs a message containing the EDI data and sends it to TIBCO 
BusinessConnect EDI Protocol powered by Instream.

To run the process:

1. Click the Tester tab.

2. Click Start testing viewed process .

Figure 7   Select Process to Load

3. Select the check box next to Send EDI As Text Through Gateway.
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4. Click Load Selected.

5. Select Send EDI As Text Through Gateway.

6. Click Start Test .

Figure 8   Message Sent Thru Gateway

7. The designated file has been read and sent through the Gateway.

Expected Results

Once the X12_5010_850 message has been received by TIBCO BusinessConnect EDI 
Protocol powered by Instream, messages are written to a file on the local file system when 
it simulates sending the interchange to the trading partner. What you can observe:

• The SendX12ThruGateway activity of the Send EDI As Text Through Gateway process 
should contain output that indicates that the X12_5010_850 message was successfully 
sent to the trading partner.

• The directory c:\testEDI\out should contain a file which contains the 850 that was sent to 
the trading partner by TIBCO BusinessConnect EDI Protocol powered by Instream.

• The audit log should contain entries that for each processing state that occurred in 
TIBCO BusinessConnect. See View the Audit Log on page 23.
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View the Audit Log

To view the audit log on the Initiator machine, perform the following steps:

1. Click the BusinessConnect > Log Viewer link in the left panel. 

2. Click the Gateway link.

3. Select items from the following lists: Status, Connection, and Date Range.

4. Click Search.

Figure 9   Gateway Audit Log Search Results

5. Click the Details icon  in the left-most column of the Search Results area to view 
details of the transaction.

6. Compare the audit log entries on your Initiator with Figure 10. 

The figure contains a detailed successful transaction.
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Figure 10   Initiator Transaction Detail

7. Click the icon next to the specific transaction to see more details.

Figure 11   Transaction Details: State RESEND_RECEIVED_FROM_PP
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Chapter 3 Managing Validation and Conversion

This chapter describes how to manage validation and conversion when using the Gateway 
protocol. 

Topics

• Overview, page 26

• Configuring Validation and Conversion, page 27
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Overview

TIBCO BusinessConnect EDI Protocol powered by Instream uses predefined operations 
in Gateway to send and receive EDI documents for the Gateway-enabled trading partners.

The following operations are predefined upon installation of TIBCO BusinessConnect 
EDI Protocol powered by Instream:

• EDIFACT

• TEXT

• TRADACOMS

• X12

• XML

When a document is received through a Gateway trading partner, TIBCO 
BusinessConnect validates the content of the request and ensures that the document type 
conforms to one of the predefined protocols. 

For incoming EDIFACT, TEXT, TRADACOMS, and X12 documents, TIBCO 
BusinessConnect determines if EDI validation and XML conversion are required. This 
determination is based on the option for validation and conversion in the Inbound Action 
tab in the screen Edit <protocol> Document Transmission for Group EDI: <protocol>.
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Configuring Validation and Conversion

When a document is received through a Gateway trading partner, TIBCO 
BusinessConnect determines if EDI validation and XML or TEXT conversion are 
required. This determination is based on the setting of the check box Enable (xxx) 
Validation and Conversion. To configure the available validation and conversion type for a 
selected protocol, perform these steps:

1. Using TIBCO Administrator, select BusinessConnect> Operations Editor.

2. Click the Gateway link 

Click the topmost + (plus) sign to display the tree.

Figure 12   Edit Gateway Operations

3. Click the protocol link, such as X12.

The dialog New X12 Document Transmission is shown on Figure 13.

Figure 13   Edit X12 Document Transmission
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Document Transmission Tab

This tab contains data that cannot be modified:

• Name: Selected document transmission type (EDIFACT, TEXT, TRADACOMS, 
X12, or XML)

• Description: Pre filled as "WARNING: Do not Modify"

TIBCO BusinessConnect EDI Protocol powered by Instream utilizes predefined 
operations in Gateway to send and receive EDI documents for Gateway enabled trading 
partners.

Outbound Action Tab

The Outbound Action tab contains the following fields:

Inbound Action Tab

This allows you to configure the following data:

Table 2   Outbound Action for Document Transmission

Field Description

Name Enter the name for this transmission.

Description Enter the description for this transmission

Direction Initiator to Responder (pre-filled)

Table 3   Inbound Action Tab

Field Description

Name Enter the name for this transmission.

Description Enter the description for this transmission

Direction Responder to Initiator (pre-filled)
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Enable (XXX) 
Validation and 
Conversion

This check box allows for different validation and conversion choices, depending on the 
document transmission type:

• EDIFACT, X12 Enable EDI to XML (or EDI to TEXT) Validation and Conversion

For more information about this option, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Validation and XML Conversion" and "TEXT to 
EDI Conversion."

• TEXT Enable TEXT to XML Validation and Conversion

For more information about this option, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "TEXT to EDI Conversion."

• TRADACOMS Enable EDI to XML Validation and Conversion

For more information about this option, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Validation and XML Conversion".

• XML No validation and conversion options are available if you are using the XML 
document transmission type.

If the check box is not selected, the EDI document is not parsed and no EDI validation and 
XML or TEXT conversion is performed. In this case:

• The entire EDI document is published to the private process under the subject 
AX.BC.installation_name.Gateway.RESPONDER.REQUEST 

• The payload is populated under the rawRequest field of binary type. 

• If the Log Raw Request to File setting (see Logging Tab on page 34) is enabled, the 
incoming or outgoing EDI document is written to file accordingly and the requestFile 
field is populated with the corresponding file reference.

Table 3   Inbound Action Tab (Cont’d)

Field Description
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Chapter 4 Setting Up Trading Hosts

This chapter describes setting up the trading host in TIBCO BusinessConnect EDI 
Protocol powered by Instream when using Gateway.

Topics

• Configuring the Gateway Protocol for Hosts, page 32

• General Tab, page 33

• Logging Tab, page 34
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Configuring the Gateway Protocol for Hosts

To enable the Gateway protocol:

1. Click the BusinessConnect > Participants link in the left panel. 

2. Click a host participant link in the right panel.

3. Click the Protocols tab.

4. If Gateway is not displayed in the list of protocols:

a. Click Enable.

b. Select the Gateway check box.

c. Click OK.

5. Click the Gateway link. The following configuration options are available:

— General Tab, page 33.

— Logging Tab, page 34.

6. Click Save.
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General Tab

To set host’s general properties, use the data from Table 4.

Table 4   General Fields

Field Description

AS2 Identifier An identifier to use in the AS2-From header field of the HTTP message. This 
identifier should be mutually agreed upon between trading partners. This 
identifier can be an interchange ID. 

This only applies when using AS2 transport.

Valid Email Address List The identifier to use in the From header field of the SMTP MIME message. 
This email address list can be a list of email addresses. For an outbound 
document sent to the trading partner through SMTP transport, the first email 
address is used in the From header. For incoming email from the mail server, 
the To email address from the email is matched to one of the email addresses in 
this list. 

This only applies when using AS1 or AS2 transport.
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Logging Tab

Use the Logging tab to configure EDI-specific logging options available with TIBCO 
BusinessConnect EDI Protocol powered by Instream. 

For further information, see TIBCO BusinessConnect EDI Protocol powered by Instream 
User’s Guide, "Document Archiving." 

Table 5   Logging Fields

Field Description

Inbound

Log Raw Request to 
File

Log the inbound or outbound EDI documents that are transmitted through the 
Gateway.

Threshold (bytes) The payload size above which the payload is streamed to a file and a file reference is 
passed in the message instead of the payload itself. This affects messages flowing 
between the BusinessConnect engine and the Interior Server and for messages 
between the Interior Server to the private process.

Store Location Enter a valid file system location. The original inbound EDI documents are stored in 
a directory whose name is derived from the specified location. 

Include Date Folder Creates a file reference in a folder created based on the current date.

Outbound

Log Raw EDI 
Request to File

Log the original, intact and unconverted EDI documents. This option is also used for 
Insight reporting. 

Outbound Insight reporting at Gateway level is supported for batching cases. To 
enable this, check the options: 

• Gateway TP > Gateway protocol > Batch Tab > Outbound > Publish 
Information to Insight Reporting for Batch, and

• Host > Gateway protocol > Logging Tab > Outbound Log Raw EDI Request to 
File.

Store Location The original inbound EDI documents are stored in a directory whose name is 
derived from the specified location. 

Include Date Folder If checked, the date folder is added to the document path. 

If unchecked, the date folder is omitted and the document is stored under the tpName 
directory.
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Chapter 5 Setting Up Trading Partners

This chapter describes how to set up a transporting Gateway for trading partners.

Topics

• Configuring the Gateway Protocol for Partners, page 38

• General Tab, page 39

• Batching Tab, page 40

• Transports Tab, page 42
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Configuring the Gateway Protocol for Partners

To configure the Gateway protocol for trading partners, perform the following steps:

1. Click the BusinessConnect > Participants link in the left panel. 

2. Click a partner participant link in the right panel.

3. Click the Protocols tab.

4. If Gateway is not displayed in the list of protocols

a. Click Enable.

b. Select the Gateway check box.

c. Click OK.

5. Click the Gateway link. The following configuration options are available:

— General Tab, page 39.

— Batching Tab, page 40.

— Transports Tab, page 42.

Trading partner’s Gateway cannot be enabled with any other EDI protocol standards.
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General Tab

To configure the General tab and set the properties for the transporting Gateway use 
Table 6. 

Table 6   General Fields

Field Description

AS2 Identifier An identifier to use in the AS2-To header field of the HTTP message. This 
identifier should be mutually agreed upon between trading partners. This 
identifier can be an interchange ID. This only applies when using AS2 
transport.

Valid Email Address List The email address that is used to match against the incoming email from the 
mail server. If the incoming email From address matches to any email address 
in this list, then this trading partner is picked as the receiving party. This only 
applies when using AS1 or AS2 transport.

Inbound

Partner Level Security 
Option (MIME Encode 
Messages Only)

Select what kind of messages you expect from this partner for this particular 
transaction set from among the following options: 

• None

• Plain Text Only 

• Signed Only

• Encrypted Only

• Signed And Encrypted

For example, if you expect only signed messages for this particular transaction 
set from a partner, but the partner, or someone posing as the partner, sends this 
particular transaction set in a plain text message, TIBCO BusinessConnect 
rejects the message.

If a message is rejected, it is logged as an ERROR transaction and an error 
advisory is published. The rejected message is not published to the Responder 
private process.

If an incoming message is sent as plain text and contains an interchange with 
multiple transaction sets, only the transaction sets that have the security option 
specified as Plain Text Only for the trading partner are accepted.
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Batching Tab

Use the Batching tab to manage outbound batching for your EDIFACT or X12 partners 
that are using this transporting Gateway. These settings are used if this Gateway trading 
partner name is entered in the Gateway (override scheduler and transport settings) field in 
a trading partner's EDIFACT or X12 Batching tab. See Product Overview on page 2 for 
more information.

Table 7   Batching Fields

Field Description

Outbound

Allow Single 
Transmission for 
Multiple Exclusively- 
batched Interchanges

If the Batch Option list for a transaction action is set to Exclusively, then the 
interchange containing this transaction can only contain this type of transaction. 
But you can still put multiple interchanges, each containing different types of 
transactions, into a single batch and send it to the trading partner.

This option and the option “Increment Interchange Control Number by 
Operation ID for Exclusive Batch” are mutually exclusive. 

Increment Interchange 
Control Number by 
Operation ID for 
Exclusive Batch 

Select the check box to increment control numbers based on transaction types in 
addition to partner ID qualifiers. Used only for exclusive batching.

If the option “Always Create Batch per Trading Partner” is disabled and the 
document is routed from different trading partners, then the outbound document 
would contain 'n' number of outbound interchanges, each interchange represented 
for each trading partner per transaction type, since the documents are exclusively 
batched.

This option and the option “Allow Single Transmission for Multiple 
Exclusively-batched Interchanges” are mutually exclusive. 

Regenerate Control 
Number For Batch 
Resend

You can override generation of a control number for batch resend for a trading 
partner using X12 or EDIFACT protocol by selecting/unselecting this check box.

To select control number regeneration for these protocols, see TIBCO 
BusinessConnect EDI Protocol powered by Instream, X12 Configuration, 
Regenerate Control Number For Batch Resend.

Publish Information to 
Insight Reporting for 
Batch

If enabled, this option will publish a report based on the Instream results file 
along with EDI data file and other information required by the Insight Reporting. 

The report will contain messages received from the trading partner, both 
synchronous and asynchronous.
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Always Create Batch 
per Trading Partner

Normally, when partners share a gateway or VAN, a single batch may contain 
mixed document types such as 850 and 101 that are intended for different 
partners. Example: One batch of 850s and 101s for distribution at the VAN to 
different trading partners.

If you check this field, separate batches are created for each partner, but each 
batch can now contain a mixture of different document types such as 850 and 
101.

Outbound XML to EDI 
Data Encoding for 
Batch*

Specify the type of encoding for outbound XML to EDI data.

This field is required.

The default value is US-ASCII.

Table 7   Batching Fields (Cont’d)

Field Description
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Transports Tab

Use the Transports tab to configure transport settings for this trading partner. To add an 
outbound transport, click Add in the Transports tab. 

The following transports are available for use with this protocol:

• HTTP

• FTP/S

• FILE

• AS2_HTTP/S

• AS1_EMAIL

• EMAIL

• SSHFTP

• Inbox

Inbox option is available in order to allow for document exchange between partners 
running TIBCO BusinessConnect EDI Protocol powered by Instream and one of these 
products: 

— TIBCO BusinessConnect Plug-in for SSH Server

— TIBCO BusinessConnect Plug-in for FTP Server

— TIBCO PartnerExpress

For more information, see TIBCO BusinessConnect EDI Protocol powered by 
Instream, User’s Guide, "Set Up Trading Partner Transport via Inbox."

The steps required for configuring transports are the same for all protocols. Refer to the 
Transports chapters in TIBCO BusinessConnect Trading Partner Administration Guide.

The transports you configure serve as the default transports for all business agreements 
associated with this partner. 
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Chapter 6 Configuring Agreement Protocol Bindings

This chapter explains how to configure operation bindings for business agreements.

Topics

• Overview, page 44

• Operation Bindings Tab, page 45

• Document Security Tab, page 47

• Transports Tab, page 49

• Scheduled Transmission Tab, page 53

• Show Advanced, page 55
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Overview

An agreement protocol binding is contained within a business agreement. For information 
on business agreements, see TIBCO BusinessConnect Trading Partner Administration 
Guide.

Add Protocol Binding

To configure an agreement protocol binding:

1. Click the BusinessConnect > Business Agreements link in the left panel. 

2. Click a business agreement link.

3. Click the Add Protocol Bindings button. 

4. Check Gateway.

5. Click OK.

6. Click the Gateway agreement protocol binding link. The following configuration 
options are available:

— Operation Bindings Tab, page 45.

— Document Security Tab, page 47.

— Transports Tab, page 49.

— Scheduled Transmission Tab, page 53.

— Show Advanced, page 55
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Operation Bindings Tab

Use the Operation Bindings tab to configure the Gateway activities that each participant 
in a business agreement can initiate and respond to. The following properties apply to all 
the activities that you import in the Operations Editor:

• Allow All Operations Enables participants to initiate all operations configured in 
TIBCO BusinessConnect. You can modify the behavior of one or more operations by 
binding the operations in the Host ’X’ Can Initiate and Partner ’Y’ Can Initiate areas. If 
unchecked, operations must be explicitly bound in the Host ’X’ Can Initiate and 
Partner ’Y’ Can Initiate areas. 

• Non Repudiation Logging Enables logging of all operations in the non-repudiation log.

Binding a Message

The Host ’X’ Can Initiate area (where X is the host participant in the business agreement) 
lists the activities that the host can initiate and the partner can respond to. 

The Partner ’Y’ Can Initiate area (where Y is the partner participant in the business 
agreement) lists the activities that the partner can initiate and the host can respond to. 

To bind an activity in either area, perform the following steps:

1. Click Add Operation Bindings.

2. Click the topmost + to expand the activity tree. It lists the available protocols 
(EDIFACT, TEXT, TRADACOMS, and X12) plus the XML document

3. Select the check box next to a transmission.

4. Click OK.
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Edit Operation Binding for the Host

Transports Tab

To edit an operation binding for the host, click an operation binding link. 

The Transports tab provides the following options:

• Override Transports If selected, this option overrides the transports selected using 
BusinessConnect > Participants > Partner > Protocols > Gateway> Transports 
tab. 

• Override Outbound Transports

You can override these transports by selecting which one is the Primary and which one 
is the Backup transport, or by selecting None (no changes).

— Primary Transport Select one of the existing configured transports, or None.

— Backup Transport Select one of the existing configured transports, or None.

Edit Operation Binding for the Partner

To edit an operation binding for the partner, click an operation binding link. The following 
options are available:

Override Action Settings

If selected, this option overrides the settings configured using 

General Settings

Depending on the protocol selected, the following options will be available:

• EDIFACT, X12    Enable EDI to XML (or EDI to TEXT) Validation and Conversion

• TEXT   Enable TEXT to XML Validation and Conversion

• TRADACOMS   Enable EDI to XML Validation and Conversion

• XML    No validation and conversion options are available if you are using the XML 
document transmission type.

For more information, see Enable (XXX) Validation and Conversion, page 29.
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Document Security Tab

Use the Document Security tab to specify security information for a transporting 
Gateway that can be shared by multiple EDIFACT or X12 trading partners. The keys and 
certificates selected in the tab are set in a host and the Gateway participant’s Credentials 
tab. See TIBCO BusinessConnect Trading Partner Administration for information on how 
to set credentials. The properties listed in Table 8 can be set for inbound and outbound 
document exchange.

The document security settings in the transporting Gateway are used instead of the 
document security settings for the EDIFACT or X12 trading partners.

Table 8   Document Security Fields

Field Description

Outbound Doc Exchange
Signing Info Settings

Signing Key The key the host uses to sign a message in order to identify itself to a partner. The partner 
uses the host’s certificates file to authenticate the host by verifying the digital signature of 
the host.

Digest 
Algorithm

The algorithm used to create the digest: SHA1, SHA256, SHA384, SHA512 or MD5

PGP Signing 
Private Key

The PGP key the host uses to sign a message in order to identify itself to a partner. 

PGP Hash 
Algorithm

The PGP algorithm used to create the digest to be used for digital signatures:

MD5, SHA1, RIPEMD160, MD2

Encryption Info Settings

Encryption 
Certificate

The certificates file the host uses to encrypt a document before sending it to the partner. The 
partner uses its own host key identity file to decrypt the document.

Encryption 
Algorithm

The algorithm used to encrypt documents: DES3, RC2-40, RC2-128, AES-128, AES-192, 
AES-256

PGP 
Encryption 
Public Key

The PGP public key the host uses to encrypt a document before sending it to the partner. 
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PGP 
Encryption 
Algorithm

The PGP algorithm used to encrypt documents:

DES3, BLOWFISGH, CAST5, AES-128, AES-192, AES-256.

Inbound Doc Exchange
Signing Info Settings

Verification 
Certificate

The partner identifies itself by signing a document with its own host identity-key file. The 
host uses this certificate to authenticate a partner by verifying the digital signature of the 
partner.

PGP Signing 
Verification 
Public Key

The host uses this PGP public key to authenticate a partner by verifying the digital 
signature of the partner.

Encryption Info Settings

Decryption 
Key

The host uses part of the host key identity file to decrypt a document that the partner 
encrypted using the host’s certificates file.

PGP 
Decryption 
Private Key

The host uses this PGP private key to decrypt the document.

Table 8   Document Security Fields (Cont’d)

Field Description
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Transports Tab

Use the Transports tab to set transport information for a transporting Gateway. A 
transporting Gateway can be shared by multiple EDIFACT and X12 trading partners, 
while it is not supported for partners using the TEXT or TRADACOMS protocol.

The top section of the tab is used for selecting transports for the outbound, or host to 
trading partner, direction. The bottom section of the tab is used for selecting and 
configuring transports for the inbound, or trading partner to host, direction.

Setting the Outbound Transport for the Host

Select an outbound primary and backup transport. The transports are configured in a 
trading partner’s Protocols > Transports tab. 

See Transports Tab on page 42.

Table 9   Outbound Transport for the Host

Field Description

Primary Transport See the Transports chapters in the TIBCO BusinessConnect Trading Partner 
Administration. 

Backup Transport TIBCO BusinessConnect EDI Protocol powered by Instream supports a backup 
outbound transport for sending EDI documents to the trading partner. This backup 
transport is used if the document could not be sent via the primary transport 
configured in the business agreement. Such situation may happen if the trading 
partner’s server is not available or has a wrong URL during the time the document is 
being sent: the document still needs to reach the server via some other means even 
after the primary transport retry was exhausted.

Backup transports are configured at the business agreement level and can be one of the 
supported BusinessConnect transports. The same rules apply for choosing a backup 
transport as for a primary transport.
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Setting the Inbound Transport

What displays in this area depends on the transports that are selected in the Transport 
Type area of the Public Process Configuration tab. For further information, see the 
section on Deployment Configuration in the TIBCO BusinessConnect Trading Partner 
Administration.

AS2 Async MDN 
Reply Transport

Same as for TIBCO BusinessConnect.

Select any of the configured transports. The settings from the specified AS2 MDN 
Async Reply Transport field are used for sending async MDN responses back to your 
trading partner. Configuring the AS2 MDN Async Reply Transport is not necessary 
unless you would like to specify different values for the following HTTP transmission 
related settings: 

• Retry Count – default is 3

• Retry Interval – default is 60 seconds

• Socket Timeout – default is 300 seconds (5 minutes)

Any other settings specified in the AS2 MDN Async Reply Transport are ignored. The 
most common case for which you would specify this transport is when your trading 
partner is not acknowledging the receipt of your async MDNs within the default 
socket timeout period.

AS2 Async MDN 
Remote Server 
Certificate

The Remote Server Certificate for the AS2 HTTPS transport is a SSL certificate that 
should be used for encrypting the data sent using HTTPS. This dropdown list contains 
all of the certificates that have been configured for the Trading Partner. You can select 
the one that was configured to be used for SSL encryption.

Note The server certificate configuration is only required for Async MDNs via AS2 
HTTPS transport. 

Client 
Authentication 
Identity for 
HTTPS, FTPS, 
HTTPSCA

Choose between the transport that was set up as Client Authentication Identity for 
HTTPS, FTPS, HTTPSCA, or None.

Client 
Authentication 
Identity for 
SSHFTP

Choose between the transport that was set up as Client Authentication Identity for 
SSHFTP, or None.

Table 9   Outbound Transport for the Host (Cont’d)

Field Description
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For inbound processing, FILE and HTTP transports do not provide trading-partner 
information. Therefore, Gateway does not use FILE or HTTP transports for inbound 
processing. If FILE or HTTP is configured as the transport, Gateway uses the associated 
business protocol instead. For example, if the message type is X12, Gateway uses the X12 
protocol for transport. This does not apply to AS1, AS2, EMAIL, or FTP transports 
because these transports provide trading-partner information in headers or URLs.

Table 10   Inbound Transport Fields

Field Description

HTTP/S Allow HTTP/S connections from this partner directly or from a VAN. 

This also applies when the inbound connection is using the AS2 transport. 

HTTPSCA/AS2 See TIBCO BusinessConnect Trading Partner Administration, Chapter 11, HTTP, 
HTTPS, and HTTPSCA Transports.

FTP/S Allow the host to perform FTP/S connections with this partner. The host is the Initiator 
of the FTP process. Click Edit Settings to configure FTP/S. 

See TIBCO BusinessConnect Trading Partner Administration Guide for more 
information on how a host uses FTP.

EMAIL Allow email from this partner or from a VAN. This also applies when the inbound 
connection is using the AS1 transport. 

If your partner uses EMAIL and a transporting Gateway to send EDI documents back 
to you through a VAN, you need to configure the FTP transport. You must use FTP to 
get your partner’s documents from the VAN site. This is because a VAN receives 
documents for multiple trading partners, but does not forward those documents to the 
recipients.

FILE Allow FILE connections from this partner. FILE is normally used for file exchange 
within an enterprise. 

If your partner uses FILE and a transporting Gateway to send EDI documents back to 
you through a VAN, you need to configure FTP transport. You must use FTP to get 
your partner’s documents from the VAN Gateway site. This is because a VAN receives 
documents for multiple trading partners, but does not forward those documents to the 
recipients.

SSHFTP See TIBCO BusinessConnect Trading Partner Administration, Chapter 15, SSHFTP 
Transport.
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Scheduled Transmission Tab

Use the Scheduled Transmission tab to schedule the transmission of outbound batches 
for this Gateway transporting partner. One EDIFACT or X12 trading partner can use a 
Gateway transporting partner or multiple partners can share a Gateway transporting 
partner to send transmissions to a VAN.

By default, transactions are transmitted to your trading partners immediately after they are 
processed by TIBCO BusinessConnect EDI Protocol powered by Instream. Using the 
options in the Scheduled Transmission tab, transactions can be scheduled to be sent:

• Only during a specified time period

• Only on certain days of the week

• Only on certain dates

If you use this tab to control when messages are transmitted, you can use the Log Viewer 
to view, submit manually, and delete queued messages. 

Gateway-partner settings always override the trading-partner settings. If multiple trading 
partners use one Gateway partner for transmissions, check for any conflicts between the 
Gateway-partner settings and the individual trading-partner settings and determine how 
best to proceed.

Table 11   Scheduled Transmission Fields

Field Description

Enable Enable this configuration.

The transaction will not route through the Gateway if this check box is not enabled.

Transmission 
Mode

The type of the transmission schedule: Everyday, Day of the Week, Specific Dates. The 
selection determines which of the other fields on the tab are used. 

Start Time Defines the start of the transmission window.

End Time Defines the end of the transmission window.

Days of the Week The days of the week that messages will be transmitted. Used when the mode is Day of 
the Week.
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Frequency How often to group transactions into a single interchange and send them to trading 
partner. 

The transmission window specified for scheduled transmissions still applies when you 
select a frequency. When the transmission window opens, pending transactions for this 
trading partner are grouped together and sent at the frequency selected.

The frequency you specify is applied to the scheduled transmission start time. The first 
transmission will be at the scheduled transmission start time. Each subsequent 
transmission will be at the start time plus the frequency interval specified. 

For example, if the start time is 9 AM. and the frequency is Every 30 mins, then the 
first transmission will occur at 9:00 AM., the next transmission will occur at 9:30 AM., 
and so forth.

Transaction 
Count Threshold

Limit the number of transactions in an interchange. 

If scheduled transmissions are enabled, entering a number will cause the following to 
occur when the transmission window is open:

• If the number of transactions to be sent to this trading partner reaches the number 
specified in this field before the next transmission time is reached, all transactions 
up to the number specified will be grouped together into a single interchange and 
sent to the trading partner.

• If the next transmission time is reached before the specified number of transactions 
are ready to be transmitted, the transactions that are ready will be grouped together 
into a single interchange and sent to the trading partner.

When scheduled transmissions are enabled, the transmission time is always based upon 
the starting time. 

Scheduled Dates The list of dates when transmission will occur. Used when the mode is Specific Dates.

Table 11   Scheduled Transmission Fields (Cont’d)

Field Description
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Show Advanced

Use the participant configuration tabs to override the general settings for a participant per 
agreement protocol binding. To view the participant configuration tabs, click the Show 
Advanced button. 

TIBCO BusinessConnect console displays two tabs labeled ParticipantA’s Configuration 
and ParticipantB Configuration, where ParticipantA and ParticipantB are the participants 
in the business agreement. 

To hide the participant configuration tabs, click the Hide Advanced button.

Override Settings

To override a general setting, perform the following steps:

1. Click a participant configuration tab.

2. Select the Override Settings check box.

The available settings are the same as those specified for the host in General Tab on 
page 33 or the trading partner in General Tab on page 39. 

3. Modify the desired settings.

4. Click Save twice.
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